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I. Installation Instructions
-- Place the Satellite_Shoreline_Mapper folder on your Desktop

-- CoastSat downloads imagery through Google Earth Engine (GEE) which requires users to register at

https://signup.earthengine.google.com/. Requesting access to google earth engine can take up to a day

so we suggest you do that first. See troubleshooting section for ways to tackle GEE related errors.

● You need to use a gmail account to sign up for Google Earth Engine

-- Install ArcPro

-- Install Anaconda

● The version of Anaconda should not matter. If you already have it on your computer you should

be able to use the one you already have

● ACE-IT users: if you don't already have Anaconda download the Anaconda 2019.10 python 3.7

version from the app portal (see troubleshooting for help)

● Other users: https://www.anaconda.com/download

-- Open Anaconda prompt and cd into the Satellite_Shoreline_Mapper directory (should be on your

Desktop). Your prompt should say (base) <path to Satellite_Shoreline_Mapper directory>
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-- Create the CoastSat Environment by typing:

conda env create -n coastsat_gui --file environment.yml

-- Test the coastsat_gui environment

conda activate coastsat_gui

Your terminal will change from starting with (base)to starting with (coastsat_gui)as shown in

the second line below:

-- Once you have access to GEE, open anaconda prompt and type:

conda activate coastsat_gui

python

import ee

ee.Authenticate(auth_mode = ‘notebook’)

1. A web browser will open prompting you to log into your google account.

2. Then it will take you to a page that says Notebook Authenticator.

3. Create a cloud project with a name with only lower case letters, numbers and dashes. This name

must be unique to proceed but does not impact the rest of the process.

4. Do not select the check box that says Use read-only scopes.

5. Then click generate token and you will see a button that allows you to copy the token.

6. Copy and paste that into your Anaconda terminal.

7. Type “ee.Initialize()” to ensure Earth Engine is authenticated

-- Setup runCC.bat

1. To edit runCC.bat, open Notepad. Click File>Open and then navigate to the directory or location

where you have Satellite_Shoreline_Mapper stored. Open runCC.bat. Alternatively, you can right

click on runCC.bat and select “Open with > Notepad”

*Note: Make sure in the bottom right you have it set to all files and not just .txt files*

2. Open the Anaconda prompt and find the path to your Anaconda by typing where anaconda.
It should be similar to ‘C:\Users\username\Anaconda3’,however this depends on

your Anaconda set up.

a. In the example below three paths show up. In this case the path is the first part of each one:
C:\Anaconda3
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3. Change the 4 hardcoded paths to your computer (example image below):

a. In the orange box change the directory to [path to your Anaconda]\Scripts\activate.bat

b. In the yellow box change to [path to your Anaconda]

c. In the blue box change to [path to your Anaconda]\envs\coastsat_gui\python.exe

d. In the green box change to the path to your Satellite_Shoreline_Mapper folder. Find this path

by typing cd into your Anaconda Prompt while in the Satellite_Shoreline_Mapper folder.

This path should be [path to Satellite_Shoreline_Mapper ]\cc\cc_LZMST.py

Make sure that the quotation marks are still there from before you started editing paths.

Save the changes with ctrl+s or File>save

Now, you’re ready to open the tool in ArcGIS!

-- Open ArcMap, without a template
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-- Insert Tab, Add folder

-- Navigate to Satellite_Shoreline_Mapper which should be on the Desktop, press “ok”
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-- Click on the ‘Insert’ tab, ‘Toolbox’, ‘Add Toolbox’, click "Satellite_Shoreline_Mapper.tbx"
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-- View catalog pane, "Satellite_Shoreline_Mapper.tbx" should be in the toolboxes section

Extract_CoastSat_Shorelines is the toolbox. Right click on Extract_CoastSat_Shorelines and click open to

access the tool

II. To Create a Shapefile:
-- Select the “View” tab and select “Catalog Pane”

-- Navigate to the folder you wish to add the shapefile to, right click and select “New” and “Shapefile.”
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--Once you have entered your info, hit “Run”

--Click the “Edit” tab and select “Create”
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--Under the “Create Features” tab, select your shapefile and the first polygon icon.

-- Click four corners of your area of interest. Be sure to include a sufficient amount of land and water (see

example below). Roughly 50% should be land and 50% water. Double click to complete the

polygon.

--Good shapefile example:
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Bad shapefile example:

III. Input Parameters
Is this a repeated run? [boolean]

If you have run this site before, you can check this box to skip the downloading portion of the

code which can be resource intensive. In a re-run, you only need to change the sitename

parameter.

Shore Polygon Filename? [.shp]

Include the path to a shapefile in which you are interested. Do not include any quotations and

use only one ‘\’The shapefile must contain only one polygon with exactly 4 points.
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Instructions to create a shapefile in section II. To create a shapefile

Start Date [yyyy-mm-dd]

Include the first day you would like to download imagery from in a yyyy-mm-dd format. Imagery

archives began in 1984.

End Date [yyyy-mm-dd]

Include the last day you would like to download imagery from in a yyyy-mm-dd format.

Contour? [m in ref to msl]

In reference to msl, what elevation contour would you like to track?

Estimated Slope? [int, unitless]

It is encouraged that you include one estimated slope for your study site. This is used to tidally

correct the shorelines. If you do not have an estimated slope, keep -999 and it will use

CoastSat.Slope. When using CoastSat.slope we recommend a longer dataset (20+ years) so that

the tool has ample amounts of imagery. CoastSat.slope is most accurate when the ratio of the

tidal range/beach slope is less than 10.

Tidal Gage Number? [int]

A list of gages can be found in the output folder inside Satellite_Shoreline_Mapper. Please type

in the line number of the tide gage number you need minus 1. If you do not know the gage

number and keep the default value of -1, it will find one for you.

Transect spacing [m]

What distance spacing would you like your cross-shore transects to be generated?

IV. Running the Tool
After you fill the parameters described in section III, hit run!

In the bottom of the geoprocessing panel, the screen will display a progress bar reading

“Extract_CoastSat_Shorelines Running…. Shortly after, it will change to a green box with the writing

“Extract_CoastSat_Shorelines Complete”.

This means the tool was successful in setting up the python environment, but it has not run the Coastsat

yet. Coincidently, a command prompt will open (below) and start running CoastSat.
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It will download all available imagery, then ask the user to choose a good satellite image. The left arrow

on your keyboard will signify it is a bad image and the right arrow will make that satellite image the

reference shoreline image.

Example of a bad reference image:
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Example of a good reference image:

Hit the “keep” button on the screen or press the right arrow on your keyboard. It will then ask you to

draw a shoreline on the image. It does not matter what end (N, S, E, W) you start on, but click points

following the shoreline in the image. See examples below of good reference shorelines.
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It will then extract shorelines from all downloaded imagery. This portion may take about 30 minutes

depending on how long your dataset is. After that portion is done, a figure will pop up and ask you to use

the right arrow to indicate it is a ‘good’ or the left arrow key to indicate a ‘bad’ shoreline similar to the

reference shoreline choice. After 5 ‘good’ shorelines, the model will start to label shorelines ‘good’ or

‘bad’ by comparing the current shoreline to the ‘good’ shorelines. If the current shoreline is within 75%

similarity to the ‘good’ shorelines, it will keep it.
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Then, a set of cross-shore transects at 10 meter spacing will be generated as well as a set of transects at

the spacing you requested. The shorelines will be tidally corrected using the water level recorded by the

user-input or tool retrieved tidal station at the time of image acquisition and the user or coastsat

generated average beach slope at every 10 meter transect. Once it is finished, it will tell the user where

the output files are below.

V. Output Files
All of the output files are saved in the site directory located within the

Satellite_Shoreline_Mapper/output/data folder structure.

There should be four folders labeled jpg_files, L5, L8, S2, and Timeseries Plots. The L5, L8, and S2 folders

contain the raw satellite imagery downloaded through Google Earth Engine along with the associated

metadata files. The post-processed, classified imagery is saved inside jpg_files/detection. The bad folder

holds the imagery the classification was bad and produced an unrepresentative shoreline. The

Timeseries Plots will have a figure showing the user-indicated spacing transects colored by the linear

regression rates along your whole site and a figure for each user-indicated spacing transect showing the

cross-shore evolution through time. That figure will have every shoreline position in blue, a moving

average shown in orange, and a linear regression rate shown in red.

metadata (pkl) - contains a dictionary for each satellite (L5, L8, S2). Inside the dictionary are 4 lists of

certain attributes for each of the satellite images downloaded, the georeference accuracy of the image

(acc_georef), the date, the EPSG, and the filename.

sitename_output (pkl, shp, geojson) - this contains the raw (not QAQCd nor tidally corrected) shorelines

extracted using coastsat. In the pickle file, the coordinates are saved in the ‘shorelines’ element. Also

saved in the pickle file is the percent cloud cover in the image, the date, the filename, the geoaccuracy,
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the classification (sand, water, whitewater, other land) of each pixel in the image (imClassifs), the

MNDWI threshold for the image, and the satellite that took the image.

sitename_outputTidalC (geojson) - this contains the final (QAQCd and tidally corrected) shoreline points

as a geojson. In addition to the coordinates of the shoreline, the file contains the date of each of the

shorelines, the satellite name that captured the image, the geoaccuracy of that image, and the percent

cloud cover. If this file contains many ‘bad’ shorelines, see section V.

sitename_outputTidalC_lines (shp) - this contains the final (QAQCd and tidally corrected) shorelines as a

shapefile. In addition to the coordinates of the shoreline, the file contains the date of each of the

shorelines, the satellite name that captured the image, the geoaccuracy of that image, and the percent

cloud cover. If this file contains many ‘bad’ shorelines, see section V.

*An important note: because of the way the tool calculates the tidal correction, the tool removes points

for quality control out of the shorelines generated, thus the lines shapefile appears to smooth over some

of the shoreline. These tidally corrected shorelines might appear smoother than the corresponding non

tidally corrected shoreline for that date. They are meant to be representative and show a general trend.

A user can plot them as points if they wish using the geojson or in python using the points in the shapefile

sitename_outputTrim (shp) - this contains the QAQCd (not tidally corrected) shorelines extracted using

CoastSat. In addition to the coordinates of the shoreline, the file contains the date of each of the

shorelines, the satellite name that captured the image, the geoaccuracy of that image, and the percent

cloud cover.

sitename_reference_shoreline (geojson, shp) - these are the coordinates of the reference shoreline the

user drew while running the tool.

cross_distance (pkl) - for every transect generated, there is an array of distances. This distance is the

distance from the landward endpoint of the transect and where the shoreline intersects that cross-shore

transect.

cross_distance_tidally_corrected (pkl) - for every transect generated, there is an array of distances. This

distance is the distance from the landward endpoint of the transect and where the tidally corrected

shoreline intersects that cross-shore transect.

transect_time_series (csv) - cross_distance.pkl repackaged as a csv file where columns are transects and

rows are the times of each shoreline with its distance to the landward endpoint of the transect. Empty

cells are distances that were removed in QAQC

transect_time_series_tidally_corrected (csv) - cross_distance_tidally_corrected.pkl repackaged as a csv

file where columns are transects and rows are the times of each shoreline with its distance to the

landward endpoint of the transect. Also includes column of the tide at the time of each shoreline. Empty

cells are distances that were removed in QAQC

slope_ests (pkl,txt) - a record of the satellite derived beach slope estimate at each transect from

transectSmall. The average of these beach slopes is used for the tide correction.

TideStationSelection (png) - figure illustrating the distance from the user’s site and the nearest tide

gauges. A low resolution shoreline is illustrated in black dots. The red dot is the center point of the study
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site, the cyan dots are the surrounding tide stations (labeled with the number associated in the

Satellite_Shoreline_Mapper/output/gages.txt file)

transects (pkl, shp, geojson) - the transects created with the tool at the 10 m spacing

transectsFull (pkl) - the transects created with the tool at 10 m spacing

transectsroots (shp) - all the points that make up the landward extent of each transect in transectFull

transectsRotations (pkl) - rotation of transects that are used to create transects perpendicular to shore,

instances of Rotation (scipy.spatial.transform.Rotation)

transectsSmall (shp, geojson) - the transects created with the tool at the user defined spacing

VI. Rerunning a Site (optional)
This last step is for reducing the amount of ‘bad’ or noisy shorelines in the output files. If the

sitename_outputTidalC_lines.shp file created has too many ‘bad’ shorelines, the model is not able to

weed out enough of the bad shorelines at this site. In this scenario, the user would go into the

coastsatv2\output\data\sitename\jpg_files\detection directory and manually move bad shoreline

images into the ‘\bad’ directory. Then, go to run the tool with the same parameters, but check the box

next to ‘is this a rerun?’. This will indicate to the tool that all the remaining shorelines in the detection

directory are ‘good’ shorelines and it will perform the tidal correction on only those shorelines.

VII. Appendix

1. Troubleshooting Errors

1.1.Gcloud missing:

Follow the instruction here: https://cloud.google.com/sdk/docs/install

1.2.GEE Bad Request:

______________________________________________________________________

conda activate coastsat_gui

earthengine authenticate –-auth_mode=notebook

______________________________________________________________________

A web-browser will pop up and ask you to sign into your gmail account. Then it will ask for access

to your account and the cloud, allow for both. You will then receive a new authentication token,

copy and paste this into the anaconda terminal when it asks for the new authentication token.

if you don’t see ‘enter verification code:’, rerun the ‘earthengine authenticate

--auth_mode=notebook’
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command and go through the process again. For more information, go to the official website

below:

https://developers.google.com/earth-engine/guides/access

1.3.Connection Error:

This is a common error during the image downloading process of CoastSat. Delete the site

directory that was created by the tool (Satellite_Shoreline_Mapper\output\sitename) and rerun

with the same parameters. The connection broke or timed out.

1.4.Downloading Anaconda from the App Portal

** This tool should work with most versions of Anaconda. If you already have one installed, you

can use that version. **

ACE-IT Users: Some versions of Anaconda on the USACE App Portal don’t install correctly. As of

April 2023 the working version was 2019.10. However, the App Portal updates often so that

version may no longer work. If you are having issues downloading Anaconda (Anaconda prompt

doesn't appear, anaconda navigator does not open correctly, etc.) try:

1. On the app portal uninstall Anaconda and install a different version

2. Reach out the ACE-IT for support

Other users: make sure you are downloading the the correct version for your computer off of

https://www.anaconda.com/download

2.5 Warnings shown

These warnings will pop up on every run. They are expected and can be ignored. They do not

affect the accuracy of the process

2.6 ShapeFileException (or other file exception errors)
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If you get an error (example shown above) that says “Unable to open…” you might have one of

the files from a previous run open (either in arcGIS, Excel, or another application). This will result

in the code not being able to access it. Close the indicated file and restart the run.

2.7 FileNotFoundError

If you get an error (example shown above) that the file or directory does not exist when you are

trying to run a rerun:

1. It is possible that the first run failed for some reason and the needed files to rerun do

not exist. Run the tool again, unchecking the rerun box

2. Check your spelling of sitename. In the above example the sitename should have been

TESTARC, but was written as TESTATC.

2.8 SpecNotFound

Make sure you are in the Satellite_Shoreline_Mapper directory

2.9 shapely.errors.GEOSException: IllegalArgumentException
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This error indicates that there are too many “bad” shorelines that made it through the classifier. Please

see section VI. Rerunning a site (optional) on page 16.

2.10 If images fail to download completely, a re-run will not work:

FileNotFoundError: [Errno 2] No such file or directory:

'C:\\Users\\frfuser\\Desktop\\Satellite_Shoreline_Mapper\\output\\data\\Duck_15yr\\metadataO.pkl'

VII. Contact
If you have questions/problems that are not covered in this manual please reach out to our development

team:

Ian Conery

Ian.W.Conery@usace.army.mil

Shannon Brown

Shannon.M.Brown@usace.army.mil

Katherine DeVore

Katherine.R.DeVore@usace.army.mil
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